BRADOC DATA MANAGEMENT
RELEASE NOTES

Bradoc System (Important, Please Read):

e  HCFA 1500 is now referred to CMS-1500

e The version checks file path is no longer stored on each user’s machine;
it is now stored in the database to minimize machines from not getting
updates when needed.

e Key Code Required — Modules/ Features that are available for an
additional cost.

_DATA MANAGEMENT

VERSION 5.6.1.30-1

Bradoc Login Form:
¢ Changes were made for users who can’t directly access the server’s/ Host Machines MedMan.exe. If the version on their
machine does not match the version stored in VERINFO (ProdVer Field) they will receive an message box explaining the
situation and then the program will close. They will not be able to access Bradoc until they run the Bradoc_Setup.exe.

Insurance Processing (NSF):
e Removed last batch re-run capability and replaced it with test run (no update) capability.

Patient Registration/ Fee Sheet Printing (Key Code Required):

e  This feature is available in the Patient Registration Module, under the Tools menu option called Fee Sheet Label

Patient Receipt Printing (Key Code Required):

e The ticket number field was added to the entry form along with the print file. If the payment was made by check, the check
number will be displayed next to the ‘CHECK’ in the payment type field. The records will be printed out in receipt number
ascending order. The chart number can be entered manually instead of going through the chart number search field. When
selecting the receipt printing from the master form, the patient information will appear in the receipt-printing module. This
feature is available in the Patient Registration Module, under the Tools menu option called Patient Receipt. This feature is
also available in Appointment scheduling in the Dr. Schedule By Patient tab, by highlighting a patient and pressing (SHIFT +
4)

*%%* Fee Sheet Printing **%*:
e The template folder location storing the fee sheet templates has changed from the user’s C:\BREXE Folder to the current
users My Documents folder.

Patient Listing Module:
¢ Internal Code Search — There was a bug with module when trying to search for patients linked to a specific internal code.
The problem was caused when the value of the internal code was changed form numeric to alphanumeric.

CMS-1500 Processing:
e Removed code that prevented referring doctor information from being submitted if the referring and rendering physicians are
the same person.

Appt Scheduling:
¢ Clients using customized features to the fee sheet process were experiencing missing diagnosis code, this issue was re-looked
at and has been resolved



VERSION 5.6.1.23-1

Appt Scheduling:
¢ C(lients using customized features to the fee sheet process were experiencing missing diagnosis code, this issue has been
resolved

Insurance Processing (UB92):
e Made changes to get correct path for placing exported download files in the current users “My Documents” folder for clients
using terminal server.
e Added HCPCS and two modifier fields to Medicare/A download file; required for Medicare/A claims

Insurance Process (Other):
e  Changes to get insurance vendor name for INS IN PROCESS record from patient insurances.
e Added code to accumulate only payments as prior paid amount for tickets with Medicaid secondary. Both payments and
adjustments are normally accumulated.

Patient Receipt Printing (Key Code Required):

* A new module was created to allow printing of receipts for patients who need a receipt for paying their co-pay or payments
on their account. A separate report can be generated for receipts received during a specified date range. This feature is
available in Patient Registration located in the menu option Tools -- > Patient Receipt. It is also available in Appointment
Scheduling in the Doctor by Patient tab, highlight a patient name and press (SHIFT + 4) to activate the Receipt Module.

VERSION 5.6.1.10-1

Insurance Processing (UB92):
e Change to include 4™ diagnosis code in the electronic download file. Only diagnosis codes 1-3 were being submitted.

Insurance Processing:
e Code was added to bypass birthdate and sex code edits for company accounts.

CMS - 1500 Print File:
e  Print file field PHGROUP field length was changed from 15 characters to 20 to accommodate larger group numbers.

VERSION 5.6.1.2-1

Insurance Processing (UB92):
e Changes made to correct M/A payer ID and secondary insurance reporting problems in Medicare and Medicaid electronic
download files. Also made changes not to list WS/I as a secondary insurance.

VERSION 5.5.1.26-1

Insurance Processing (UB92):
e  Changes made to correct payer ID and provider number problems in electronic download file. Fields are now created from
vendor payer ID and source of pay fields.

VERSION 5.5.1.25-1

EMR:

e Issue with reading PDF’s has been fixed. If a user experiences problems reading PDF’s, they must install Adobe 7.0 and
have the file ACRO32.exe on their system to work.

Insurance Processing:
e Correction made to prevent accessing previously read Medicare UB split file record.
e Change to bypass accessing the VENDAA file for demand claims; already being done in program HCFAD2. Coding error
was causing Medicare DME address to print out instead of Medicare B.



VERSION 5.5.1.17-1

Appomtment Messaging System (Key Code Required):

Changes were made to ensure that patient is not checked in twice from the appointment-scheduling module.

The module will now display the user from the reception desk who checked the patient in, along with date/ time.

The refresh rate to check the file for new patients was changed from 3-4 seconds to approximately every 30 seconds.

The user now has the ability to pause the refresh rate.

Code was also added to store the user, date/time of who checked the patient out. The form is now refreshed after the users
closes out the Doctor/Nurse setup form.

EMR Custom Scanning Setup:
*  Bugs were fixed that prevented the uses information from appearing when entering the users custom scanning defaults
screen, along with displaying multiple defaults for the specified scanner.

Insurance Processing:
¢ Changes were made to include facility address, city, state and zip for purchased services claims.

VERSION 5.5.1.15-1

Insurance (Terminal Server Users):

e Changes were made to place PC-ACE and ANSI download files in the current users ‘My Documents’ folders if the clinic is
connected to Terminal Server. Additional steps are then needed to move files to the specified location by using a short-cut
from the users machine to the their terminal server desktop.

Insurance:
¢ Changes were made to include facility address, city, state and zip for purchased services claims.

VERSION 5.5.1.9-1

Zip Code Analysis:

e Coding error preventing accurate accumulation of patients based on zip codes has been fixed.

CFreedom Module: (Key Code Required)

e Code was added to pass patient appointment information to CFreedom for patient process/ billing. Manually, the output files
from CFreedom are processed and read into Bradoc for assisting in charge posting.

UB92 Demand Review: (Key Code Required)

¢ Coding changes were made to allow the user to view UB92 demands in a UB92 format. The user can modify the UB92
before printing. The user should be aware that there are not checks for invalid entries. In the future the user will be able to
view the demands on an actual UB92 form.

¢  Form displays all demands selected by the user for editing and/ or printing. The Bradoc System does not populate all fields
with the background color of yellow.

Diagnosis Code:
® Added editing for period entered within diagnosis code (not allowed).

Referring Doctor Maintenance:

e Added new field (M/A provider #) to referring doctor maintenance program, and changed HCFA programs to use the new
field to print in box 17 of CMS-1500 instead of the UPIN # for SD Medicaid claims.

County Maintenance:
e The County field length was increased from 2 to 3 characters

Insurance Processing:
® A new field was added to store the DME Supplier number in the facility file maintenance program. The CMS-1500 print
program was changed to display the DME supplier number in box 33.



e  Changes to get correct vendor name for INS IN PROCESS transaction in Medicare alternate address situations.

e  Changes to include primary care physician / referring doctor information in Medicaid electronic claims.

e Changes made to CMS-1500 electronic insurance process, to include Tricare claims processing for both PC-ACE and direct
file downloads. Also made other minor corrections, including removal of code for second (overflow) Blue Shield and
Medicare work files, and Commercial claims processing corrections.

¢ Changes made for Medicaid UB-92 emergency room claims to show values of 1 in type of admission and 7 in source of
admission (FL19 and FL20). Changed for paper and electronic claims.

CMSS838 Module:

e Changes were made to correctly add the amounts for Medicare reimbursements.

Patient Listing Report:
e New feature added to allow the user to specify a doctor number and facility and retrieve all patients that were seen by that
doctor.

VERSION 5.4.1.17-1

CMS-1500 Demand:

e A new field was added to store the DME Supplier number in the facility file maintenance program. The CMS-1500 print
program was changed to display the DME supplier number in box 33.

VERSION 5.4.1.5-1
CMS-1500 Demand: (Key Code Required)

e (lients can now view the demanded insurance claims on an actual CMS-1500 form. The user can modify any field, print the
selected ticket or print all tickets demanded. Currently in beta testing.

Insurance Processing:
e Code was changed to prevent referring doctor name from printing in CMS-1500 Box #17 if the referring doctor. UPIN # was
not entered.

VERSION 5.4.1.1-1
Nurse Notification Module: (Key Code Required)

* A new module was created to allow the front desk/ reception person, to notify the nurse/ doctor that a patient has arrived and
is waiting to be seen. Currently in beta testing.

Main Bradoc Form:
e  The form now displays the user’s current Bradoc System version

VERSION 5.3.1.25-1
CMS-838 Report:

e Changes were made to check the current detail for any ticket information that should be applied to the net amount

Insurance Processing (CMS-1500) {Previously Known As HCFA 1500}:
e Changes to blank out CMS-1500 boxes 9 — 9d data if Work Comp was being shown as secondary insurance. Also changed to
mark ‘No’ in box 11d of the form.
e The HCFA form was changed to allow for printing of the phone number in box 33. Because the requirement of pitch 12 is
required on the HCFA form things had to be squeezed in.

Insurance Processing (UB-92):

e Changed electronic and paper demand UB-92 programs to check for and bypass transactions coded to go only on a CMS-
1500 form.

Version Check:
e Added the ability to add the version check path for verifying version of main medman to the users local machine’s medman.
This can be modified from: Menu Option File > Admin - Add/Update User Information = Version Check Path Setup. A
path location name of ‘M AIN’ must be established containing the path to the server/ host machine medman.exe.



¢  For machines that have problems accessing the network, can be assigned its own location name containing a path they can
access to verify versions. This can be updated/ added in the Update User’

VERSION 5.3.1.14-1

Insurance Processing (HCFA-1500)
e  Changes in Blue Cross & Blue Shield Insurance, BOX 24 A: The “TO” date is required and this was modified for all
insurance vendors.

VERSION 5.3.1.9-1
Nightly Process:

e Was not rebuilding the doctors grid of the schedule contained one doctor for the given day.

Ticket Review:
e Was not correctly calling the patient registration form if the form was currently minimized.

Appointment Scheduling:

e  Changes were made to allow clients using appointment entry to use the DYMO label printer for print fee sheet labels

VERSION 5.3.1.4-1

Login Form:
e The login form changed not only appearance wise, but how the current user machine determines if an update is needed.
Instead of the user’s machine storing the path to the main MEDMAN on the server/host machine for version checking, the
path will be stored in the database. This will eliminate machines from not being updated, which have occurred in the past.

Insurance Processing:
e Added use of ‘file path’ field in insurance vendor file for location of download file placement
e  Changes to print up to a 13-digit provider # in box 51 of the UB-92 form.
e Added more qualifying logic in checks that prevent UB-92 transactions from going HCFA electronic. Also added demand
override that sends claims HCFA electronic unconditionally.

Electronic Medical Records (EMR):
e If a document is approved and marked as read-only it will be displayed in the EMR. However, if the document is later
marked for deletion, it will still be displayed. Code has been added to check the file status of the record to see if it has been

marked for deletion. If it has, it will not be displayed in listing.

Dictation Module:

e  If the last document was marked for deletion any new files would be marked for deletion. I now clear the format after
retrieving the last record information.

VERSION 5.2.1.18-1
Fee Sheet Label Printing:

e Code was added to specify printing the patient number for X-ray labels for specific clients. Some clients want patient
numbers displayed, others do not.

VERSION 5.2.1.17-1
Electronic Medical Records (EMR):

¢ Dictation Tab - code was added code to correctly check for any file attribute condition containing read only status. Code was
also added code to eliminate an possible unknown files in the directory to be eliminated from EMR listing so all file listing
can be selected.

¢  Fixed the issue when the original MASTER DATA path was not created. Before, it was creating an error and shutting down
the Bradoc System.

Dictation Module:
e Code was added code to correctly check for any file attribute condition containing read only status. Code was also added
code to eliminate an possible unknown files in the directory to be eliminated from EMR listing so all file listing can be
selected.



¢ Eliminated the issue with receiving the ‘Run-Time Error in Dictation @ Line 1386; invalid property array index’, an array
counter was not being reset after a new chart was entered. Also, the error when not creating the MASTER DATA file path
has been fixed. Before, it was creating an error and shutting down the Bradoc System.

Insurance Edit Form:

e Eliminated the issue with receiving the ‘Run-Time Error in Insur @ Line 1122; invalid extract length.” The problem deals
with file extensions that are two characters, such as those that are created when an image is created in MS XP for thumb nail
selections. Also, the error when not creating the MASTER DATA file has been fixed. Before, it was creating an error and
shutting down the Bradoc System.

Fee Sheet Label Processing:
e Changes were made to account for creating a new member for the LABFS and LABXRAY files. It now checks to see if a
member for the user has already been created and if so removes it before creating a new one for fee sheet label print. Before,
the WORDFEE file was accumulating a large amount of created members.

VERSION 5.2.1.1-5

Insurance Processing:
e Change to prevent price reduction modifiers for physician assistants from being blanked out in Medicare electronic download
file. Medicare now requires modifiers to be submitted.

Bradoc System:

¢ Change was made to system to account for correct number of forms opened. Error occurred to electronic insurance users.

VERSION 5.1.1.1-11

Insurance Processing:
e Correction made to bypass deleted insurance

VERSION 5.1.1.1-10

Insurance Processing:
¢  HCFA Insurance Form Printing — Some of the new print drivers aren’t following the windows standards and we haven’t been
able to set up the print tray correctly. The user now has the option to set up the printer settings in the batch or demand
processes. If they click on the menu option File they will see a Printer Setup option. Note — At this time the changes were
only set up for HCFA printing. The UB print process will be changed later.
e Changes were made to correctly generate the Work Comp PC-ACE import file.

Recall Processing
e Bug Fix — If a chart number was found to receive a recall card and the chart number did not exist in the Recall file, the user
would receive an error.

VERSION 5.1.1.1-7
Insurance Processing:
e Changes to accumulate and report total UB-92 Welfare amounts.
¢ Changes to get report heading by facility, and to indicate whether report is being generated for paper or electronic claims.

VERSION 5.1.1.1-6

Insurance Processing:
e Added logic to print Prior Payments (box 54) and Estimated Amount Due (box 55) for Medicare and Blue Cross UB-92
claims.
e  Changes to print 11-character Pin# in Box 33 of HCFA forms for out-of-state Medicaid claims.
e  Change to use the MN/MA provider number in the PC-ACE import for MN-based clinics.

Medicare Credit Balance Report:
e Report listing all tickets with credit balances based on payor code entered. This report in located under the Reports menu
option, Special Reports category.



VERSION 5.1.1.1-5

Appointment Scheduling:

The patients internal code message will flash on the screen after a chart number has been entered
The patients last diagnosis code will be retrieved based on the doctor’s group number. You have the doctor’s group’s setup
correctly for this to be effective. This is by request only.

Alternate Revenue Codes:

Added code to check for and bypass deleted ALTREYV file records

Insurance Processing:

Changes/ corrections were made to the programs involving the HCFA commercial electronic download process.

Dictation Module:

Fixed code with patient age being less than one year old, will now display (d) days when age is less than a month and display
(m) months when age is less than one year.

When marking a document for deletion, the user will now be prompted with a message box making sure they are intending to
perform the action.

Added ‘DOEVENTS?’ to the print que module, hoping to solve the issue with printing batch documents.

Reminder Letters:

Fixed bug when printing letter type reminder letters. On some printers, will print landscape instead of portrait.

VERSION 5.1.1.1-1

Patient DB Search:

Created a new program that allows the user to enter a visit date range, followed by search criteria based on patient age,
gender, diagnosis code use/ along with CPT codes used or not used, and zip code. This is by request only.

Recall Processing:

Added new print format to print two recall on 8x11 recall card
Added logic for select query to decrease the process time

Insurance Processing:

Changed to use new patient relationship codes only if printing to paper UB-92.

HCFA Insurance Processing:

Added code to select the users default printer if an error occurs when assigning a custom printer.

Daily Proof Listing:

Added code to select the users default printer if an error occurs when assigning a custom printer.

VERSION 4.1.1.60

Insurance Processing:

Major changes were made to the insurance processing.

Changes to blank out facility information for claims with place-of-service 12 (home health) for PC-ACE import file.
Change to print total dollar amount for primary insurance in box 55 of UB-92 form.

Modifications needed due to file changes made in insurance processing changes of 7/6/2004.

Added logic to include HCPCS code and modifiers for lab procedures in NSF download file.

Corrections made to create HAQ record for box 19 data entered (imports into PC-ACE narrative field); removed logic that
was allowing only two modifiers and one diagnosis pointer for Medicare claims; and removed logic that was stripping
leading zeros from patient MN Medicaid ID number

Added checks to send UB transactions on a HCFA form if visit date is prior to UB effective date, even if no ‘X’ code is
present (No UB-92) in the bill code record.



Change required in payer ID field for Trailblazer Medicare A file import for PC-ACE

Added logic to export Medicare A download file (BM837I) to C: drive

Correction to code that bypassed demanded transactions for non-primary insurances.

Added change to select W/C insurance in primary run, even if not coded primary.

Added logic for outside lab REF*F4 segment if Medicare or M/A and mod. 90 present, and logic for NTE*ADD segment for

additional line item information, if print description code E or B present.

e Added logic for Medicare Method II Effective Date, for sending both portions of split transaction to Medicare UGS for
qualifying visit dates.

e Added logic to submit new HIPAA-compliant patient relationship codes in paper and electronic UB-92 claims.

e  Changes in HCFA print program for box 19 data, to print for all payers instead of only Medicare, and in 837 download
program to include NTE* segment for procedure group ‘H’ (NOC Drug) transactions. Also corrected functional group count
error in segment IEA* in program INS837

e Changes required to send POS 21 (inpatient hospital) transactions to HCFA electronic download or paper form.

Electronic Medical Records Module:
e  Added logic to hide dictation documents that have not been approved

e Added code for checking the file attributes. Was only checking for attribute of ‘1” when it was possible to have an attribute
of 33’

Dictation Module:

e Removed timing logic between creating the dictation document and entering information into the document.

e The Chart Number field was increased from six characters to nine characters

e Added code for checking the file attributes. Was only checking for attribute of ‘1° when it was possible to have an attribute
of ‘33’

e The birth date of the patient is now based off the visit date
The user can now select a file and press the 'P' key to preview a document in the Dictation Print Module
After the user selects a letter document to create, a box will appear asking if they want to revert back to a chart note after the
document has been created. Also added, a bold text label next the "Enter Dictation" button for more visual information as to
what type of document they are creating.

e The user can now select a file and press the D' key to mark a document for removal. After a document has been marked for
deletion, the row will be highlighted in red. They can also unselect a marked document by pressing the 'D' key again.

e Added a new module, Dictation Delete Module, to allow an authorized user to review the documents marked for deletion and
remove them. I still have to add code to move the marked documents from the current Master Data folder into a new folder
for backup, just in case it really wasn't an "oops" document. To access this module from the Dictation Module, select Tool --
> “Delete Marked Documents”. Remember, only authorized users can access this module.

The caption for the main Dictation Module now contains the USER ID. The User ID is also displayed on the form.

Added code so that the person who created the document, can be the only one that changes the documents delete status.
Changes were made to the doctor approval module so the subfile is cleared after the approval button is clicked. The doctor
number then retains focus.

¢ Changes were made to the dictation print que module so the subfile is cleared after the print button is clicked. The user id
field then retains focus.

Ticket Information Screen:
e Added Primary Paid Amount field to the ticket information file maintenance screen.

Vendor Maintenance Form:
e Added a field to signify that the vendor is included for UDS table S-CHIP reporting. If the vendor code should not be
included for this processing, an ‘N’ code needs to be entered in the VENDOR S-CHIP field

Bill Code Maintenance Form:

e Added a field for signifying that the bill code will be used during processing encounters reports, i.e. facility encounters and
UDS table reporting. If the bill code should not be included, an ‘N’ code needs to be entered in the ENCOUNTER
TRACKING field.

Rolling Code Payor Code:
e  There is a new report for rolling payer code. It is under the special reports and labeled Rolling Payer Code Aging Report.

This report will give an aging out to one year of the current rolling payer code value of every ticket in the system.

Main Bradoc Form:



e Added logic to prevent the user from double clicking on the appointment-scheduling button. When the button is first clicked,
it is disabled until the process is completed, then it is re-enabled.

e Added a new menu option REPORTS - SPECIAL REPORTS > FACILTY ENCOUNTERS. This program will create a
report displaying the encounters that occurred for each facility for the date ranged entered.

VERSION 4.1.1.50

Dictation Module:

e  Made changes for a client so a line does not appear when appending to the main document. Changes were made to store the
user query settings in both the print que form and the doctor approval form. These settings are stored in the DictQury file.
Users can now sort dictation documents by timestamp.

Electronic Medical Records Module:
e  Changes were made to prevent the Dictation tab from highlighting when documents exist in the master data folder and they
are not approved. Changes were also made how the files headings are displayed when viewing the dictation tab.

Insurance Processing:
e Change to get complete M/A provider number for download; was pulling only 5 characters of the number.
e  Added check for type-of-vendor code C (Medicaid) for Medicaid download processing
e Made change to receiver ID field in download file for MN PC-ACE import file for MN Medicaid claims.

Refund Check Module:

e Collate feature under File > Properties > Advanced tab must be unchecked.

Appointment Scheduling:
e Added a button to the Doctor Schedule tab for creating an XML file used by the CFREEDOM program. This is only
applicable to specified clients

VERSION 4.1.1.40

Clinic Profile:
¢ Added maintenance for new fields TSTPRD and UBEFDT for insurance purposes.

Charge Posting Screen:

e The user will now be able to change the account number when posting charges. This was specifically added to allow the user
to post to a company account. This will make it easier for the clinic to track their company accounts but still post to the
correct chart number. In the past the user had to post to the companies account and put the chart number and patients name in
the description. They can now use the patients chart number and override the account number with the desired number. This
ticket will now show up on the other accounts statement.

Payment Posting:
e  Made correction in payment posting module to handle another invalid ticket # format in the remit file.

Microsoft Word Fee Sheet Processing:
e Added logic to prevent an error if trying to print fee sheets and no branch code has been established. Primarily for new
clinics being established.

¢ Added logic to include the fee sheet remarks. Also changed logic to sort the insurance vendors so the primary vendor will be
VENDORI, secondary will be VENDOR?2, Tertiary will be VENDORS3 and other will be VENDOR4
e Added logic to prevent an error if trying to print fee sheets and no branch code has been established.

Patient Registration:
e Added feature to allow the user to print a medical record label. To access this feature, click the PRINT menu option =>

Select ‘Print Medical Record Label’.

Diagnosis Report:



e Added feature to allow the user to specify if the date range entered will be used to locate master based on birth date. To
access this feature, click the ‘Use Date For Birth Date Search’ check box and enter the corresponding diagnosis codes and
date range. When the report is generated, only masters in the date range will be included in the report. The user can then
print mailing labels based on the records displayed.

Microsoft Word Fee Sheet Processing:

e  Added evaluation condition when copying templates from server to local machine. Would cause error if user has template
open or previous MS Word error occurred.

e Added code to bypass any record locks when processing fee sheets. If a record lock does occur, the user will be notified to
re-run fee sheets to complete the fee sheet process.

e  Add evaluation conditions to check for errors when processing the fee sheets. Before, the program would kick the user out of
appointment scheduling if error occurred. Now it prompts the user that an error occurred, closed the WINWORD.exe task,
and prompts the user to repeat the process again.

Recall Card Process:
e Added logic to preview the selected recall card when setting up the recall cards.
¢ Fixed code to correctly display the selected logo in the recall cards. Prior, in the recall card setup form, if there was no
information in the clinic name, the logo would not print.

Electronic Medical Records:
e Added logic to print a full 8.5x11 inch document in both the main Electronic Records form and when the user view the full
image.
e Added a new program called E-IMAGERIGHTS.vrf to allow the system administrator to determine which users will have
rights to delete a file from the Electronic Medical Records. Only the administrator will have access to the “Delete Rights”
menu option located in the Tools menu. The administrator can then select the users they want to have this right.

Ticket Review:
e Code was changed to exit caption displaying the credit status of the account.
e  When the user enters in a ticket number, that ticket number will be centered in the grid.

Insurance Processing (HCFA):

® Another change that will be noticed immediately is the HCFA paper and electronic demand insurance screens. The user will
now be able to have the demand insurance screens open and still do account reviews, posting of charges and payments, and
other tasks. The screens used to be opened in a format that only allowed the user to access the demand screens

e  HCFA-1500 paper and electronic demand insurance screens now display the insurance designation of the insurances for the
entered chart. Also, it displays the deleted insurances with red lettering and displays a red ‘D’ under the deleted column.

® Programs modified to allow percentage split of transactions to send both UB-92 and HCFA in electronic and paper insurance
processing.

e  Made changes to bypass transactions coded for UB-92 processing in these select programs.

Insurance Processing (INUB):
e UB-92 electronic demand program now available for all clinics in need of it; changed paper insurance process to read the
demand file and allow updates to the YRTRN file.
e Programs modified to allow percentage split of transactions to send both UB-92 and HCFA in electronic and paper insurance
processing.
e  Made changes to bypass transactions coded for UB-92 processing in these select programs.

VERSION 4.1.1.35

Rolling Payor Code Process:

e Two fields were added for the rolling payor code logic. VDTROLL: stores days to roll to self-pay; VNOROLL.: this is a no
roll vendor.

Patient Registration Form:

e Added field to display the patient’s age and patient’s work phone extension. Code was also added to display the age in a
certain colored font depending on the age group: 0 — 17 = RED; 18-20 = BLUE; 21+ = BLACK Code was also added to
display the internal code description depending on the patients internal code.

Additional Information:

e Added fields to display the cell phone number, email address and field if the patient wants to receive information by email.

(Logic for emailing has not been added as of yet.) Fields were rearranged.



Internal Code Update:
e The description field for the internal code was extended to 50 characters.
INUB Process:
¢ Changes to the print file were made display the full doctor name in Box 82 of the UB-92 Form.
User Update Form:
e Added code so the user only views profiles with the same MAINLIB
Patient Correspondence:
¢ Fixed code to allow the user to use mixed case when entering patient correspondence. Checks are made to ensure the users
entered data is saved when exiting the program. Patient Correspondence field is now enabled when the user loses focus and
returns (only if the Acct# and Chart# have not changed and contains values).
Appointment Scheduling:
e  Made Coding Change to Appointment Scheduling for the special fee sheet process. Previously, existing appointments were
being duplicated with new ticket number assigned.
Insurance Process:
e Corrected coding error for printing of group # in Box 33 of HCFA forms. Changes were also made to display the full
description in Box 19
Recall Cards:
e Added a procedure to allow the user to reprint recall cards. The user can begin this process by clicking the Reprint Recall
Cards checkbox, and then select the desired recall card. The user can also begin printing from a specified chart number.

VERSION 4.1.1.30

Bradoc System Conversion:
e Changes were made to the code for compatibility with AVR 3.5
Nightly Processing:
* Nightly process will only be able to run once for a given date. If an attempt is made to run nightly process twice for the same
day, an error message will appear.
e The Limbo file is backed up to the MAIN history library (i.e. BRADOCH with the following name, LIMB + 20040327’
being the date this is processing for. This date is then stored in the ANBDAY file in the APPT folder.)
e The MAPON file is backed up to the APPT backup folder. This folder will be created automatically if it does not already
exist. The naming convention is the same as above (i.e. MAPON + 20040327)
e Under the tools menu option, they will have the ability to review the log from the last nightly process. If there is an error in
the nightly process, they will not be able to run nightly process again until they accomplish one of the following:
1. Delete the log file
2. Place the text ‘No Error’ at the end of the current log file
Dictation:
e Made changes for the dictation document creation process. It was to correctly creating a document, instead it was creating a
merged document. This correction will work for both Word 2000 & Word 2003
Appointment Scheduling:
e  Made changes to the book schedule. The appointment time and type frame was not appearing.
Payment Posting:
e Corrected the process to check for delete codes for the file EMCPMT file and bypass those records.

VERSION 4.1.1.21

Bradoc System Conversion:
e Changes were made to the code for compatibility with AVR 3.5
Electronic Payment Posting:
®  Added the facility as part of the key to the doctor provider # file.
e  Program was also converted to AVR 3.5
Electronic Medical Records:
e Made change to scanning of a two-sided document. The initial scanner selected was being reset when the first side scan was
completed
Appointment Scheduling:
e  Made changes to the program to eliminate the Patient Number when printing the X-Ray Labels.
Patient Review Screen:



e  The form will display a warning message if the current account has any balance in the Creditor file.
Main Bradoc Screen:
e  Users can now view the Bradoc Release Notes by selecting Help from the option menu followed by View Release Notes.

VERSION 4.1.1.20

Bradoc System Conversion:

e Changes were made to the code for compatibility with AVR 3.5
Charge Posting

e  Users can now establish default settings when posting charges. Can assign which fields are cleared.
Fee Sheet Templates & Dictation Module:

e Code was added for increased compatibility in MS WORD 2003

VERSION 4.1.1.15

Bradoc System Conversion:
e Changes were made to the code for compatibility with AVR 3.5
Recall Cards:
e  Added new format for client to print four recall cards on one sheet
e In the recall cards setup — user can now assign clinic logo to be displayed. Applies to certain recall card types.
Fee Sheet Templates & Dictation Module:
e Code was added to automatically copy the templates on the server/host machine to each local machines
C:\BREXE\Templates folder.
Reminder Letter Setup:
e  User can now clear the clinic logo by clicking the Clear Logo button.
Appointment Scheduling:
e When the appointment-scheduling module is selected, a message box will appear letting the user know that the appointment-
scheduling module is loading. This form will disappear when the process is completed.

VERSION 4.1.1.10

Bradoc System Conversion:
e Changes were made to the code for compatibility with AVR 3.5
Appomtment Scheduling/ Label processing:
Coding changes were made to eliminate the ‘000000000’ from appearing in the X-Ray labels when no patient number is
entered.

e  Users can now set a default printer (Preferably, the DYMO LabelWriter Turbo 330) to print the labels. When the form is
displayed showing the number of labels for Fee sheets and X-Ray to print, the each user then need to select the TOOLS menu
options and click Set Default Printer. Each user then needs to select a printer (Preferably, the DYMO LabelWriter Turbo
330) to establish this printer to the fee sheet label process.

Insurance Processing:

e New field added to the Clinic Profile Screen for the Doctor Facility default number. Setup default facility to get the doctor
provider numbers at facility other than their main facility. This way, the user doesn’t have to enter provider numbers for each
facility.

Charge Posting:

e Screen setting were changed to allow displaying of the Guarantor and Patient information when the second form is displayed

VERSION 4.1.1.1

Bradoc System Conversion:
e Bradoc System is now using AVR 3.5
Appointment Scheduling/ Label processing:

® Special Fee Sheets — Special can be setup for custom fee sheets. To activate this feature, select a patient appointment and
press the ‘S’ key. A form will appear displaying all the custom fee sheets already established.



® X-Ray & Lab Labels — Fee sheet labels can now be printed on a label printer. Preferably, the DYMO LabelWriter Turbo 330
should be used. Contact Bradoc for more information. This can be setup in the fee sheet profile. Note: Use AS/400 option
must be set to ‘NO” for this feature to work.

VERSION 3.4.1.1

Dictation:
e  User can now designate if the dictation document will be a letter or chart note.
e The process to approve a document now requires an identification code
¢ Dictation information will now display: Patient Name — Chart Number — Visit Date — Doctor Name in the footer section of
the document. This will be used to link multiple page dictations together.
e Field size of the facility name has been increased from 30 characters to 50 characters.
e  Clicking Tools = Print Que; user can now print a single or multiple dictation documents.

Dictation Print Que:
e Clicking Tools = Print Que; user can now print a single or multiple dictation documents.
e  User can sort the way documents are displayed by selecting a field name in the sort order box and moving the fields up and
down the listing. Doubling clicking a fields with toggle ascending and descending values of the field.
e  To further limit the displayed documents, the user can enter values in specified fields for specific results.

Dictation Batch Approve Documents:
e C(Clicking Tools = Batch Approve Documents; user can now approve a single or multiple dictation documents.
e In order for the user to approve a dictation document, the user must know the doctor’s number approval code. A user with
supervisor rights can only establish this code. To access this menu, Clicking Tools = Dr. Identification Codes. Enter the
doctor number and the password to approve the doctor’s dictation documents.

Doctor Alternate Provider #:
e Doctor Alternate Provider # file has been created to be used in association with the Vendor Alternate Address file. If the
alternate address has been designated for use, the correct provider numbers will be retrieved from the doctor alternate
provider # file.

Charge Posting:
e Charge posting now has new fields in the Ticket Information area; up to four UB-92 condition codes can be entered to print
on the UB form or for submission in electronic download files, accident state and hour are required fields for HIPAA 837
insurance claim formats. Also, there is a new field for a co-pay amount entry near the bill code entry field - this is used to
print co-pay amounts in the prior payments field on the UB-92 form and/or be included in the electronic download file. The
co-pay amount can also be added or updated in the Detail Information update under File Maintenance.

Bill Code Maintenance:
¢ In the Bill Code file maintenance program, there is a new value for Physical Therapy (I) that can be coded in the Procedure
Group field; this can be used to aid with special insurance processing if needed. There is now a dollar amount entry for
Purchased Services, which will print on the HCFA form in box 20 if needed, or go electronically.

Electronic Download:
®  Changes have been completed to code electronic insurance vendors for creation of either a PC-ACE import file or a direct
837 professional claims file, depending on the needs of the clinic. Vendors coded with a 'P' for PC-ACE in the HCFA
Electronic field will produce a PC-ACE import file, and if the HCFA Electronic field contains a 'Y', a direct 837 professional
claims file will be produced for transmission to the appropriate payor. There is also now an option to rerun the last electronic
claims batch without file updates.

VERSION 3.3.15.16

Charge Posting:
There is now a co-pay amount field in the Charge Posting program. Patient co-pay amounts can be entered for each individual
transaction — you can see the field for entry underneath the bill code entry field.

Appointment Scheduling:



Clients who use MS Word to print their fee sheets now have the ability to print walk in patients. Each client must setup of this feature
in the Clinic Profile tab under the Appointment Scheduling menu options.

VERSION 3.3.15.15

Insurance Process:
Changes were made to the NSFRUN.VREF for insurance processing.

Patent Registration:
Delete status will now accept a ‘B’ code.

Data Repository:
Made changes to the SCANDETF file. Added fields to store the users default tab, which scanner to load and if it will be a one or two
page scan.

Added a new form, REPOSIDEFAULTS to populate the new fields.

Added the ability for the user to decide Data Repository form defaults. By going to Tools = Data Repository Defaults, the user can
now establish which scanner, type of scan and tab that will be initially selected when the program loads. The user can also change
which input device driver will be associated with which scanner.

Appointment Cards:
I made changes to the field names in the APCRDSPC file and associated programs. The existing field names were to long to be stored
on the AS400.

INUB13 & INUB12:

Previous problems in array out of index error referring to the number of Vendors used in insurance processing fixed.

Rolling Payor Code:

Modifications were made to the rolling payor code process to adhere to HIPAA standards.
VERSION 3.3.15.0

Referring Doctor Update:

A search button was added to view all referring doctor for selection

Prt_Cht_Mast:
The previous code was not sorting by chart number and was displaying patient names named ‘DELETED’
Added the ability to print patient listing by patient name, patient chart or patient master number

Charge Posting Screen:
Problem with entering duplicate tickets for the same visit date fixed.

Selecting Scanners:
The user no longer needs to use the menu options to change the scanner.

Added option buttons on main screen for the user to select either the small scanner or the large scanner. If the scanner is not assigned
to a driver or the driver does not exist on the machine, the user is prompted to select a driver to assign to the specified scanner.

Custom Scanning Defaults:
Added a new file SCANDEEF that stores the user ID and the associated driver names for the large and small scanner. This allows users
to have different scanners installed on the machine.

Added a new file SCANCUST that allow users to establish default scanning for specific tasks.

The custom scan job option is available by clicking the “Custom Scanner Defaults” located under the Tools menu option on the Data
Repository form.



Users can then Add/Update/Delete custom scanning jobs specific for the small or large scanner. The custom scanning defaults will
then be available by selecting the small or large scan option button and then the default custom scan jobs established for the specific
scanner will be displayed in the drop down box. The other custom scanning jobs will be available by clicking the drop down box.
Whatever custom scan is visible in the combo box will be used to scan the document.

File Transfer:

A code change was made to the form when the File Transfer form loads. The “To” and “From” drive and directory list boxes will
default the path of Data Repository file established in the ELECFILE file. The will allow easier access to the desired files needed to
transfer from one location to another

Data Repository Form:

A code change was made for speeding up the process of scanning a document and adding the document to the Data Repository files.
After an image is displayed in the preview pane, the cursor will set focus to the file name input field. After the file name is entered, by
clicking the enter key, the cursor will set focus to the Add/Update button. By clicking the enter key again, the document is added to
the Data Repository files. After the document is added, the cursor will then set focus to the master number for selecting a new master
number if needed.

Made coding change to timing issue when trying to save an image or view the insurance screen. Prior, depending on how many
master folders existed in the Master Data directory; the length of time for the program to refresh depended on the number of folders in
the Master Data folder.

VERSION 3.3.13.0

Input Field Fix:

On some forms, input fields would rearrange the values entered. This problem has been fixed.

Insurance Processing:
Some clients have experienced problems with insurance processing if their vendor count exceeded 30. The problem has been fixed.

VERSION 3.3.12.0

Patient Registration:

There is an option within Patient Registration to control the use of the Enter key when making changes. The default for updating
fields is not to use the Enter Key for updating. To Enable the Enter Key for updating field values, go to the menu option Tools and
Click on Enable Enter Key for Update menu item. When there’s a check mark next to the Enable Enter Key for Update menu item,
the Enter Key is used for updating and conversely if there’s not a check mark the Enter Key is not used for updating fields.

VERSION 3.3.11.0

Microsoft Word Dictation:

Dictation for chart notes can now be accomplished using Microsoft Word. The chart note dictation form can be accessed using the
“Dictation Using Word” menu option located under the Medical Records menu option on the main Bradoc screen. On the Dictation
form, the user enters the chart number, doctor number, facility number and visit date, and by clicking the “Enter Dictation” button, a
chart note is created for the user to enter dictation.

All chart note dictation for the chart number will be displayed on the form for follow up entries or to view past dictations. The chart
note dictation can be deleted, but only available to system administrators with a security level of 1

Chart Number Update:

Under the Tools menu item in Patient Registration there is an option to Change/Update Chart Number, which is only available to
system administrators with a security level of 1.

This program will update all of the files for a given chart number to a new chart number. The MASTER, MASCHT, CHART, TINF,
DETD, YRTRN, LIMBO, MAPON, APAST, and APPTDEMO files will be updated when this program is run. After you update a
specific chart number to a new one, a message box will appear with the results of the update. The old chart number will be placed in
the alternate number field in patient registration.



VERSION 3.3.10.0

Reminder Letters:

The reminder letters have been changed to be more versatile and individualized. The Reminder letters are found in the Appointment
Scheduling module under Tools. You still have the option to key in the to and from date range of letters to print. You now have the
option to set up your own default letter. Click on the Setup Default button and enter your own name and address of clinic. There is an
option to insert a logo and you may compose your own sentence structures using the insert selections to the right of the sentence area.
The letter may be signed with the Clinic Name, Facility, Doctor or User name. A preview button allows proofreading of the letter
before printing.

FEE Sheet Documents:

In appointment scheduling, there is a new Fee Sheet Default feature. This new feature in appointment scheduling will allow you to
print appointment information onto your own customized fee sheets. Some setup is involved to get this program in place. A
customized fee sheet has to be created in a word document. Under Edit, select Fee Sheet Profile. Once this profile has been brought
up, select MS Word Fee Sheet. Under Tools select Print Fee Sheet. Once you are in the Print Fee Sheet screen, click on Tools and
select Assign Doc# to Template. This will bring up a Doctor Fee Sheet Setup screen. Enter the doctor number and browse to the path
of the template. (This fee sheet document should be setup in the BREXE folder and a subfolder TEMPLATE and select the fee sheet
document). Also, check the box next to default if this is the fee sheet template you want to use.

Chart Memo:

Chart Memos are informative notes for the appointment scheduler to view before making an appointment for a specific patient (chart
#). Chart Memo is found in the Appointment Scheduling module under Tools. Enter a chart # and type in the message that pertains to
this patient. Click the Add/Update button. When scheduling an appointment, an paper icon with a red blinking border will appear by
the patient’s name. Click on this blinking icon and you will be able to view the memo entered for this patient.

Edit Insurance Screen:
This is for Data Repository users only. The scanned in insurance cards can now be viewed from the edit insurance screen.

Doctor Master-Enter/Update Provider Group #:
When entering or editing provider group numbers for a doctor master, you now have the option to customize the printing in box 33 on
the HCFA. Just check which area in box 33 you want the provider # or the group # for this vendor to print.

Product Version/Update Folder:

A new option has been added to quickly view the Bradoc Version of each computer. This will help to make sure each computer has
been updated with the latest version. On the main Bradoc screen, click File/User Login/Check Update Location and Product Version.
This will bring up the Product Version/Update Folder with your PC’s version, the network version and the location.

Clinic Profile Screen Add:
Under the Provider EMC Settings new information needs to be entered in the box entitled ANSI-837. These fields need to be entered
in order for the insurance download file to be correct if you are using PC-ACE Pro32.

Dr. Provider # Entry/Update Changes:

Part of this update involves changes to the Dr. Provider # Entry/Update screen (refer to the print screen below). In order to facilitate
printing of various numbers in box 33 of the HCFA-1500 form, we have set up an addition to this screen. Note that you will now be
able to print the Provider # in either the Pin # or the Grp # areas in box 33, and the Group # has the same flexibility. You will need to
review the insurance vendors that require the printing of number(s) in this box, and make changes accordingly. BE SURE TO GET
THE CHANGES IN PLACE BEFORE YOUR NEXT INSURANCE RUN. Note the button marked CLEAR BOX 33 SETTINGS;
clicking it will remove all settings for box 33 for an existing Dr. Provider record. There are instances of special numbers that print in
box 33, and these will print as normal. Please call Bradoc for assistance if necessary.
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Update Corrections to PC-ACE:

You may have had a problem with future date errors in PC-ACE; this has been corrected.

There was an insurance select problem for UB-92 electronic M/A claims, causing them to go HCFA-1500 paper; this has been
corrected.

For PC-ACE users, patient insurances were not being shown for selection in the demand UB-92 electronic program; this has been
corrected.

PC-ACE Set-Up Procedures For Production Processing

In PC-ACE PRO-32 Software:

Payer file — we have added Medigap insurance companies to this file, so it must replace your standard payer file. Detach it from the e-
mail to the C:\WINPCACE\DATAPRO directory. Go into PC-ACE PRO-32 and go to the System Utilities screen. Click on the File
Maintenance tab. Find the file called “PAYER” and highlight it, and then click the “REINDEX” button. This is necessary whenever
this PAYER.DBF file is installed on a machine. Also, a new entry must be made in the Payer file for commercial insurance. The Payer
ID “99999” must be entered with a description of “Commercial Insurance”, LOB “COM?”, and the letter “F” in the source field, under
Flags.

Please review your provider entries (group and individual) for correctness. The Medicare individual provider # should be prefixed by
the letter “N”. Also, be sure the Trading Partner ID is entered on the Local Fields tab, and go to the Codes/Misc tab to be sure the
Submitter Information is correct. Your entries should be mostly complete from your testing process.

If you are processing UB-92 claims, review the provider entries in that section as well. Also, go to the Codes/Misc tab and set up your
providers in the “UPIN” screen, including the Tax ID numbers.

In HyperTerminal Communications Software:
Change dial-up phone number to the production claims phone number listed on the fax from EDI.

In Bradoc Software:

In the Insurance Vendor update program under File Maintenance 1, the Payer ID numbers from the Payer table in PC-ACE PRO-32
must be entered. Do not enter Medigap numbers in these fields. Numbers for HCFA and UB-92 should be entered for major payers,
such as Blue Shield and Medicare. Pay attention to the “USAGE” column in PC-ACE PRO-32; some are 1500-only, some are UB92-
only, and blank means valid for both. Also, change the -Y- in the HCFA Electronic and/or UB-92 Electronic fields to -P- (PC-ACE).



The system will produce both Medtrac/Datatrac and PC-ACE claims if so designated; just be sure that the vendors to go into PC-ACE
are coded with a -P- and leave those to go Medtrac/Datatrac with a -Y- code.

In the Clinic Profile update program under File Maintenance 1, go to screen three or the Provider EMC Settings screen, and enter your
Blue Shield and Medicare billing provider numbers, and the letter ‘N’ for the Dr. Provider number prefix for Medicare Electronic.
Also, be sure that the HCFA NSF version number is coded “3.01”. Do not change your doctor Medicare provider numbers in provider
file maintenance.

PC-ACE Pro32 Updates:

Providers should regularly check the website (www.noridianmedicare.com) for updates. Check the current version of PC-ACE Pro32
by going to Help - About PC-ACE Pro32 on the main toolbar; this shows the NAS version number. Compare this number to the
update version number on the website, and download if necessary.

Website path is www.noridianmedicare.com = provider - accept = technical documents (under EDI) = 2. HIPAA transactions -
North Dakota - Blue Cross Blue Shield (or Medicare A/B) = PC-ACE Pro32 section = pcaceup.exe. Click on pcaceup.exe to begin
download: save to your computer, find My Documents in the Save In window, and click Save. The download will begin. Note the
name in the File Name window; it is this name that needs to be located and run on the PC.

Windows Explorer can be used to access My Documents folder to run the downloaded executable, or click Start = Run, and enter the
path C:\My Documents\filename.exe to run it.

Call Bradoc for assistance if necessary.



